
  

  

MODUL AJAR
DESAIN GRAFIS

Nama Penulis                    : Dian Nugraha Rahman, S.Sos.I
Institusi                              : SLBN Cicendo Kota Bandung
Mata Pelajaran                  : Desain Grafis
Materi Pokok                     : Dasar-dasar Desain Grafis
Fase/Kelas                        : E
Tahun Ajaran/Semester    : 2024-2025/I
Alokasi Waktu                   :

 

 
Tujuan Pembelajaran

1.  Memahami dasar-dasar umum Corel Draw
2.  Mengenal menu efek pada Corel Draw
3.  Mengamati manfaat praktis hasil kerja dengan Corel Draw
4.  Mempraktekkan cara kerja pada Corel Draw
5.  Membuat projek karya dengan Corel Draw dan mempresentasikannya

Teknis Pertemuan

1.  Seluruh peserta didik di arahkan untuk berada di ruangan desain grafis dan duduk di hadapan komputer masing-masing
  lalu  memperhatikan guru untuk mendapatkan penjelasan dan arahan.

2.  Peserta didik menyalakan komputer dan mengikuti intruksi untuk mempelajari semua tema bahasan yang 
disampaikan oleh  guru.

3.  Peserta didik menyelesaikan intruksi guru dan mempresentasikan hasilnya di depan teman dan guru.

Profil Peserta Didik

Peserta didik kelas merupakan peserta didik hambatan pendengaran (tunarungu).
  Peserta didik mampu berkomunikasi dengan menggunakan pendekatan komunikasi total (komtal), mampu berdiskusi,
memahami perintah, mengenal jenis-jenis profesi. Membedakan profesi dan pekerjaan, serta mampu menggunakan
motoriknya dengan baik.
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IntroIntro

CorelDRAWCorelDRAW  merupakan salah satu pengolah grafis dengan basis vektor, dimana unsur dasar yang  merupakan salah satu pengolah grafis dengan basis vektor, dimana unsur dasar yang

mendasarinya adalah garis. Keuntungan dari vektor ini adalah gambar akan mempunyai ukuranmendasarinya adalah garis. Keuntungan dari vektor ini adalah gambar akan mempunyai ukuran

kapasitas file yang relatif kecil apabila dibandingkan dengan pengolah grafis berbasis bitmap. Jugakapasitas file yang relatif kecil apabila dibandingkan dengan pengolah grafis berbasis bitmap. Juga

tidak ada penurunan kualitas jika gambar diperbesar.tidak ada penurunan kualitas jika gambar diperbesar.

Namun demikian, versi X4 sudah menyertakan filterNamun demikian, versi X4 sudah menyertakan filter
--
filter efek pengolah bitmap dalam fungsi tersendiri.filter efek pengolah bitmap dalam fungsi tersendiri.

 Yang  Yang dapat dapat dipakai dipakai untuk untuk memanipulasi memanipulasi penataan penataan objek objek dalam dalam sebuah sebuah komposisi komposisi gambar gambar yangyang

diinginkan. diinginkan. Apapun progrApapun program grafik yang dipakai, semuanam grafik yang dipakai, semuanya terpulang pada kreatifitas dan imajinasiya terpulang pada kreatifitas dan imajinasi

pemakainya.pemakainya.

 Workspace / Area Ke Workspace / Area Kerjarja

Sewaktu membuka program, inilah beberapa lokasi penting yang Sewaktu membuka program, inilah beberapa lokasi penting yang perlu diperhatikan :perlu diperhatikan :

A.A.   Daftar Menu ProgramDaftar Menu Program  

Berbagai perintah pengoperasian mulai dari menyimpan file, membuka file, mengatur ukuranBerbagai perintah pengoperasian mulai dari menyimpan file, membuka file, mengatur ukuran

halaman, dan menampilkan berbagai menu bantuan.halaman, dan menampilkan berbagai menu bantuan.

B.B.   Icon Command ShortcutIcon Command Shortcut  
Berisi iconBerisi icon--icon jalan pintas ( icon jalan pintas (  shortcut  shortcut  ) pengoperasian berbagai pe ) pengoperasian berbagai perintah penting dari daftar menrintah penting dari daftar men

u program.u program.
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C.C.   Tools Options / Property BarTools Options / Property Bar  
Isi Isi bar bar ini adalah ini adalah property property dari tool dari tool box dan box dan akan akan berubahberubah--ubah sesuai dengan jenis toolubah sesuai dengan jenis tool

yang dipakai dan macam objek yang tengah dipilih. Isinya tidak jauh dari berbagai fituryang dipakai dan macam objek yang tengah dipilih. Isinya tidak jauh dari berbagai fitur

pengoperasian tambahan yang dimiliki oleh sebuah tool.pengoperasian tambahan yang dimiliki oleh sebuah tool.

D.D.   Tool BoxTool Box  

Berisi berbagai peralatan untuk membuat berbagai macam objek gambar dan fiturBerisi berbagai peralatan untuk membuat berbagai macam objek gambar dan fitur

tambahan tambahan yang yang berhubungan berhubungan dengan kualitas dengan kualitas visual gambar (warna, visual gambar (warna, garis dan efek)garis dan efek)..

E.E.   RulerRuler  

Penggaris bantuan yang dapat dipakai sebagai panduan dalam menentukan batasPenggaris bantuan yang dapat dipakai sebagai panduan dalam menentukan batas--batasbatas
area penataan objek.area penataan objek.

F.F.   CanvasCanvas  

Tempat mencurahkan segala bentuk kreatifitas gambar yang Tempat mencurahkan segala bentuk kreatifitas gambar yang dibuat.dibuat.

G.G.   DockersDockers  

Ekspansi atau menu tambahan dari beberapa perintah mEkspansi atau menu tambahan dari beberapa perintah menu dan juga tool box enu dan juga tool box yang sedangyang sedang

aktif. aktif. Lokasinya bisa dipindahkanLokasinya bisa dipindahkan, disembunyikan atau bah, disembunyikan atau bahkan ditutup.kan ditutup.

H.H.   Color Bar/PalletteColor Bar/Pallette  

Bar untuk menentukan pewarnaan garis (outline) dan isi Bar untuk menentukan pewarnaan garis (outline) dan isi (fill) objek.(fill) objek.

I.I.   Information BoxInformation Box  

Sebagai bar informasi mengenai objek yang Sebagai bar informasi mengenai objek yang sedang aktif.sedang aktif.

 J. J.   Page ControlPage Control  

Mengontrol tampilan halaman pada sebuah dokumen yang memiliki Mengontrol tampilan halaman pada sebuah dokumen yang memiliki banyak halaman.banyak halaman.

K.K.   Cursor PositionCursor Position

Menunjukkan posisi kursor dalam perhitungan ukuran yuang sama pada penggaris (ruler).Menunjukkan posisi kursor dalam perhitungan ukuran yuang sama pada penggaris (ruler).

L.L.   Window ControlWindow Control  

3 (tiga) buah ikon untuk menyembunyikan, membesarkan/mengecilkan3 (tiga) buah ikon untuk menyembunyikan, membesarkan/mengecilkan

dan menutup windows dan menutup windows canvas (dokumen). Berguncanvas (dokumen). Berguna sewaktu bekerja dengan banyak dokumen.a sewaktu bekerja dengan banyak dokumen.

Beberapa jenis istilah pada CorelDRAW :Beberapa jenis istilah pada CorelDRAW :
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Tool Box CorelDRAWTool Box CorelDRAW

No. No. Icon Icon FungsiFungsi
11

Pick Tool ( Pick Tool ( VV ) )
Memilih, memanipulasi danMemilih, memanipulasi dan

mengontrol objek.mengontrol objek.

22
Shape Tool (F10)Shape Tool (F10)

Memanipulasi objek kurvaMemanipulasi objek kurva

   Shape ToolShape Tool , , untuk mengedituntuk mengedit

suatu outline/kurva.suatu outline/kurva.  
   Smudge Brush,Smudge Brush, u untukntuk

mengubah bagiamengubah bagiann garis outlinegaris outline
pada objek dengan carpada objek dengan caraa dragdrag
pada outlinepada outline..

   Roughen Brush,Roughen Brush,  digunakandigunakan
untukuntuk  mengubah bagian outlinemengubah bagian outline
pada garis vektor dari objekpada garis vektor dari objek  

   Tranform Tool,Tranform Tool,  untuk memutaruntuk memutar
objek dengan bebas.objek dengan bebas.  

33

Knife ToolKnife Tool
Berguna untukmemotong suatuBerguna untukmemotong suatu

objek.objek.

TIPSTIPS

Klik pada satu sisi lalu klik Klik pada satu sisi lalu klik pada sisipada sisilainnya. Hasil potongan dapatlainnya. Hasil potongan dapat

langsung terlihat.langsung terlihat.  

44
Eraser Tool ( Eraser Tool ( XX ) )

Untuk menghapus sisi objek.Untuk menghapus sisi objek.

5 5 Zoom Zoom Tool Tool ( ( ZZ ) )

Hand Tool ( Hand Tool ( HH ) )

Memperbesar – memperkecilMemperbesar – memperkecil

ukuran tampilan pandangan.ukuran tampilan pandangan.

Menggeser tampilan layar.Menggeser tampilan layar.

66  Jika user ingin membuat Jika user ingin membuat

bentuk sendiri maka bentukbentuk sendiri maka bentuk

objek tersebut berbentukobjek tersebut berbentuk

kurva ( kurva ( CurveCurve ) baik tertutup ) baik tertutupyang dapat diisi warna /yang dapat diisi warna / fill fill  

maupun yang terbuka yangmaupun yang terbuka yang

tidak dapat diisi warna.tidak dapat diisi warna.

Lihat ilustrasi di halaman berikut…Lihat ilustrasi di halaman berikut…

Tool-tool vital untuk membuatTool-tool vital untuk membuat

gambar dengan bentuk yang sesuaigambar dengan bentuk yang sesuai

dengan keinginan user.dengan keinginan user.

   FreehandFreehand, untuk menggambar, untuk menggambar

kurva bentuk bebas.kurva bentuk bebas.

   BezierBezier   , untuk , untuk menggambarmenggambar

kurva Bezier yang mempunyaikurva Bezier yang mempunyai

handle untuk mengendalikanhandle untuk mengendalikan

bentuk kurva.bentuk kurva.

   Artistic MediaArtistic Media, untuk, untuk

menggambar kurva yangmenggambar kurva yang

mempunyai bentuk artitstic.mempunyai bentuk artitstic.

   PenPen, sama seperti Bezier Tool, sama seperti Bezier Tool

namun lebih fleksibel.namun lebih fleksibel.

   PolylinePolyline, , sama sepesama seperti Bexierrti Bexier

Tool dan Pen Tool.Tool dan Pen Tool.

   3 Point Curve3 Point Curve, membuat kurva, membuat kurva
terbuka lengkung yang presisi.terbuka lengkung yang presisi.
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   ConnectorConnector, untuk membuat, untuk membuat

konektor antar objek.konektor antar objek.

   DimensionDimension, membuat, membuat

keterangan dimensi objek.keterangan dimensi objek.

Fungsi Connector dan DimensionFungsi Connector dan Dimension

tidak dijelaskan melalui ilustratsi ditidak dijelaskan melalui ilustratsi di

 samping. samping.

PENTINGPENTING

Tool yang sering digunakan untukTool yang sering digunakan untuk

membuat sebuah bentuk objek baikmembuat sebuah bentuk objek baik

itu berupa kurva terbuka/tertutupitu berupa kurva terbuka/tertutup

adalahadalah FreehandFreehand , , ezierezier dan dan PenPen..  

77 Smart FillSmart Fill

Smart DrawingSmart Drawing

( ( Shift+F5Shift+F5 ) )

   Smart FillSmart Fill berfungsi untuk berfungsi untuk

memberi warna fill secaramemberi warna fill secara

mudah dan cepat.mudah dan cepat.

   Smart DrawingSmart Drawing berfungsi untuk berfungsi untuk

membuat gambar secara cepat.membuat gambar secara cepat.

Kedua tool di atas jarang dipakai,Kedua tool di atas jarang dipakai,

hanya untuk kepentingan tertentuhanya untuk kepentingan tertentu

saja.saja.

88 Rectangle ( Rectangle ( F6F6 ) )

3 Point Rectangle3 Point Rectangle

   RectangleRectangle, untuk membuat, untuk membuat

gambar kotak.gambar kotak.

   3 Point Rectangle3 Point Rectangle, untuk, untuk

membuat gambar kotak yangmembuat gambar kotak yang

berawal dari satu sisi.berawal dari satu sisi.

TIPSTIPS

Untuk membuat bentuk sama sisiUntuk membuat bentuk sama sisi

 yang presisi, tekan yang presisi, tekan CtrlCtrl. Untuk. Untuk

membuat dari titik tengah tekanmembuat dari titik tengah tekan

Ctrl ShiftCtrl Shift..
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99 Ellipse ( Ellipse ( F7F7 ) )

3 Point Ellipse3 Point Ellipse

   EllipseEllipse, untuk membuat, untuk membuat

lingkaran.lingkaran.

   3 Point Ellipse3 Point Ellipse , untuk membuat , untuk membuat

lingkaran yang berawal dari satulingkaran yang berawal dari satu

sisi.sisi.

TIPSTIPS

Untuk membuat bentuk sama sisiUntuk membuat bentuk sama sisi

 yang presisi, tekan yang presisi, tekan CtrlCtrl. Untuk. Untuk
membuat dari titik tengah tekanmembuat dari titik tengah tekan

Ctrl ShiftCtrl Shift..

10 10 Polygon Polygon (Y)(Y)

StarStar

Complex StarComplex Star

Graph Paper ( Graph Paper ( DD ) )

Spiral ( Spiral ( AA ) )

   PolygonPolygon, untuk membuat, untuk membuat

gambar segi banyak.gambar segi banyak.

   StarStar, untuk membuat bintang., untuk membuat bintang.

   Complex StarComplex Star, untuk membuat, untuk membuat

bintang dengan sisi menyilang.bintang dengan sisi menyilang.

   Graph PaperGraph Paper, untuk membuat, untuk membuat

kotak yang terbagi dari beberapakotak yang terbagi dari beberapa

grid.grid.

   SpiralSpiral, untuk membuat spiral., untuk membuat spiral.

TIPSTIPS

Untuk membuat bentuk sama sisiUntuk membuat bentuk sama sisi

 yang presisi, tekan yang presisi, tekan CtrlCtrl. Untuk. Untuk

membuat dari titik tengah tekanmembuat dari titik tengah tekan

Ctrl ShiftCtrl Shift..  

1111

Tool-tool yang berguna untukTool-tool yang berguna untuk

membuat objek-objekmembuat objek-objek

primitif pada umumnya atauprimitif pada umumnya atau
objek dasar.objek dasar.

Tool-tool yang sangat mudahTool-tool yang sangat mudah

digunakan, silahkan dicoba sendiri.digunakan, silahkan dicoba sendiri.

Di dalam masing-masing tool iniDi dalam masing-masing tool ini

masih terdapat bermacam-macammasih terdapat bermacam-macam
 shape shape/bentuk dasar yang siap/bentuk dasar yang siap

pakai.pakai.

1212

TextText

ToolTool

( ( F8F8 ) )

Text ToolText Tool berfungsi untuk berfungsi untuk

mengetikkan suatu teks ataumengetikkan suatu teks atau

paragraph.paragraph.

TIPSTIPS

Untuk membuat text frame /Untuk membuat text frame /

 paragraf, tekan Text Tool (F paragraf, tekan Text Tool (F8) lalu di8) lalu di

drag area yang dibutuhkan untukdrag area yang dibutuhkan untuk

menampung teks, sama sepertimenampung teks, sama seperti

membuat gambar kotak/rectangle.membuat gambar kotak/rectangle.

Lihat ilustrasi di samping.Lihat ilustrasi di samping.  
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1313
Table toolTable tool

Berfungsi untuk membuat tabelBerfungsi untuk membuat tabel

yang dapat diisi teks/data sepertiyang dapat diisi teks/data seperti

program aplikasi pengolah angkaprogram aplikasi pengolah angka

(spreadsheet).(spreadsheet).

1414 Interactive Efect ToolInteractive Efect Tool, user, user

dapat melihat & mendapatkandapat melihat & mendapatkan

efek yang diinginkan secaraefek yang diinginkan secara

cepat dengan cara mengaturcepat dengan cara mengatur

settingnya secara real time.settingnya secara real time.

   Interactive Blend ToolInteractive Blend Tool,,

berfungsi untuk membuatberfungsi untuk membuat

peralihan dari satu bentuk objekperalihan dari satu bentuk objek

ke bentuk objek yang lain.ke bentuk objek yang lain.

Bentuk kedua objek akanBentuk kedua objek akan
bercampur manjadi satu.bercampur manjadi satu.

   Interactive Contour ToolInteractive Contour Tool,,

berfungsi untukberfungsi untuk

memperbesar/memperkecilmemperbesar/memperkecil

ukuran suatu objek.ukuran suatu objek.

   Interactive Distrot ToolInteractive Distrot Tool, sangat, sangat

bermanfaat untuk ‘merusak’bermanfaat untuk ‘merusak’

bentuk suatu objek sehinggabentuk suatu objek sehingga

menghasilkan bentuk objek lainmenghasilkan bentuk objek lain

yang berbeda.yang berbeda.

   Interactive Drop Shadow ToolInteractive Drop Shadow Tool,,

untuk menambahkan efekuntuk menambahkan efek

bayangan di bawah satu objek.bayangan di bawah satu objek.
   Envelope ToolEnvelope Tool, untuk, untuk

membentuk suatu objek seolah-membentuk suatu objek seolah-

olah objek tersebut terbungkusolah objek tersebut terbungkus

oleh suatu bentuk.oleh suatu bentuk.

   Extrude ToolExtrude Tool, untuk memberi, untuk memberi

efek 3 dimensi dari objek 2efek 3 dimensi dari objek 2

dimensi.dimensi.

   Transparency ToolTransparency Tool, memberikan, memberikan

efek transparan pada suatuefek transparan pada suatu

objek.objek.

1515    Eyedropper ToolEyedropper Tool, untuk, untuk

mengambil warna dari suatumengambil warna dari suatu

objek.objek.

   Paintbucket ToolPaintbucket Tool, mengisi, mengisi

warna ke suatu objek.warna ke suatu objek.



  

   Menggambar Grafik Vektor Dengan CorelDRAW X4Menggambar Grafik Vektor Dengan CorelDRAW X4
  

   77

16 16 Segala Segala atribut atribut yangyang

berkaitan denganberkaitan dengan

outline suatu kurva atauoutline suatu kurva atau

shape diatur lewat menushape diatur lewat menu

ini.ini.

   Outline PenOutline Pen akan menampilkan akan menampilkan

kotak dialog Outline Pen sepertikotak dialog Outline Pen seperti

gambar di samping bawah.gambar di samping bawah.

   Outline ColorOutline Color akan akan

menampilkan kotak dialog Color.menampilkan kotak dialog Color.

INFOINFO  

Sebuah outline dapat memilikiSebuah outline dapat memiliki

ketebalan setebal rambut (Hairline),ketebalan setebal rambut (Hairline),
½ point, 1 point, 2 point dan½ point, 1 point, 2 point dan

seterusnya atau juga tidak memilikiseterusnya atau juga tidak memiliki

ketebalan alias tanpa outline.ketebalan alias tanpa outline.
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17 17 Tool-tool Tool-tool vital vital lagi lagi didi

CorelDRAW untukCorelDRAW untuk

colouringcolouring (pewarnaan dan (pewarnaan dan

beberapa efek) padabeberapa efek) pada

objek yang berupa kurvaobjek yang berupa kurva

tertutup.tertutup.

   Uniform FillUniform Fill, untuk mengisi, untuk mengisi

warna fill / blok warna padawarna fill / blok warna pada

suatu kurva tertutup.suatu kurva tertutup.

   Fountain FillFountain Fill, untuk mengisi fill, untuk mengisi fill

warna gradasi.warna gradasi.

   Pattern FillPattern Fill, utnuk memberikan, utnuk memberikan

patter atau pola.patter atau pola.

   Texture FillTexture Fill, untuk mengisi, untuk mengisi

tekstur pada suatu objek.tekstur pada suatu objek.
   PostScript FillPostScript Fill, untuk, untuk

memberikan efek postscript.memberikan efek postscript.

   NoneNone, menghilangkan fill pada, menghilangkan fill pada

suatu objek.suatu objek.

PENTINGPENTING::

Selalu gunakan warnaSelalu gunakan warna CMYKCMYK  jika  jika

hasil gambar akan dicetak atauhasil gambar akan dicetak atau

dikirim ke percetakan.dikirim ke percetakan.

Penggunaan mode warnaPenggunaan mode warna RGBRGB  

hanya untuk menampilkan gambarhanya untuk menampilkan gambar

di display monitor saja.di display monitor saja.

18 18 Interactive Interactive Fill Fill ( ( GG ) )

Mesh Fill ( Mesh Fill ( MM ) )

   Interactive FillInteractive Fill, salah satu, salah satu

kelebihan CorelDRAW adalahkelebihan CorelDRAW adalah

ada banyak cara untuk mengisiada banyak cara untuk mengisi

warna pada suatu objek kurvawarna pada suatu objek kurva

tertutup. Dengan tool initertutup. Dengan tool ini

pengisian warna tidak haruspengisian warna tidak harus

dengan cara seperti di atasdengan cara seperti di atas
karena bersifat interaktif artinyakarena bersifat interaktif artinya
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user dapat langsunguser dapat langsung

mengendalikan prosesmengendalikan proses

pewarnaan & melihat hasilnya.pewarnaan & melihat hasilnya.

   Mesh FillMesh Fill, berguna untuk, berguna untuk

memberi gradasi pada areamemberi gradasi pada area

tertentu pada suatu objek.tertentu pada suatu objek.

INFOINFO  

Tool Mesh Fill bermanfaat jugaTool Mesh Fill bermanfaat juga
untuk pembuatan gambaruntuk pembuatan gambar

berkualitas foto (Photorealistic).berkualitas foto (Photorealistic).

Property Bar CorelDRAWProperty Bar CorelDRAW

Seperti telah disebutkan di atas, masing-masing tool pada CorelDRAW mempunyai properti atau atributSeperti telah disebutkan di atas, masing-masing tool pada CorelDRAW mempunyai properti atau atribut

tersendiri yang bermanfaat untuk pengaturan lebih lanjut oleh user. Atribut / property tersebut beradatersendiri yang bermanfaat untuk pengaturan lebih lanjut oleh user. Atribut / property tersebut berada

didi Property BarProperty Bar yang letak defaultnya ada di atas. yang letak defaultnya ada di atas.

 Analogi sebuah Analogi sebuah Property BarProperty Bar adalah jika kita ingin menerbangkan pesawat maka y adalah jika kita ingin menerbangkan pesawat maka yang akanang akan

kita hadapi adalah kokpit pesawat beserta instrumen-instrumennya. Begitu juga jika kita inginkita hadapi adalah kokpit pesawat beserta instrumen-instrumennya. Begitu juga jika kita ingin

mengemudikan mobil maka yang mengemudikan mobil maka yang akan kita hadapi adalah dashboard mobil besertaakan kita hadapi adalah dashboard mobil beserta

kemudinya.kemudinya.

Berikut ini beberapaBerikut ini beberapa Property BarProperty Bar  berdasarkan tool yang dipakai dan sangat bermanfaat untuk  berdasarkan tool yang dipakai dan sangat bermanfaat untuk

pemakaian sehari-hari :pemakaian sehari-hari :

Property Bar Pick ToolProperty Bar Pick Tool  

Berguna untuk merubah atribut halaman kerja, mulai dari ukuran halaman, orientasi, unit dan lain-lain.Berguna untuk merubah atribut halaman kerja, mulai dari ukuran halaman, orientasi, unit dan lain-lain.

Property Bar Shape ToolProperty Bar Shape Tool  

Biasa dipakai jika kita mengedit sebuah kurva, garis, outline ataBiasa dipakai jika kita mengedit sebuah kurva, garis, outline atau sebuah shape/bentuk.u sebuah shape/bentuk.

Property Bar Free Transform ToolProperty Bar Free Transform Tool  

Sangat bermanfaat untuk mentransform (merubah orientasi objek) secara Sangat bermanfaat untuk mentransform (merubah orientasi objek) secara cepat, mulai dari menggeser,cepat, mulai dari menggeser,

memutar, merefleksi, memperbesar/kecil, memiringkan sebuah memutar, merefleksi, memperbesar/kecil, memiringkan sebuah objek.objek.

Untuk proses transformasi suatu objek secara cepat disarankan menggunakan property bar FreeUntuk proses transformasi suatu objek secara cepat disarankan menggunakan property bar Free

Transform Tool ini.Transform Tool ini.
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Property Bar Zoom & Hand ToolProperty Bar Zoom & Hand Tool  

Bermanfaat untuk memperbesar / memperkecil pandangan area kerja Bermanfaat untuk memperbesar / memperkecil pandangan area kerja atau objek yang terseleksi.atau objek yang terseleksi.

Property Bar Artitstic Media ToolProperty Bar Artitstic Media Tool

Berguna untuk mengatur settingan ketebalan, kelembutan dan gaya dari media lukis kita seperti kuas,Berguna untuk mengatur settingan ketebalan, kelembutan dan gaya dari media lukis kita seperti kuas,

alat semprot ( alat semprot (  spray  spray  ), kaligrafi dan airbrush (  ), kaligrafi dan airbrush ( PressurePressure ). ).

Property Bar Rectangle ToolProperty Bar Rectangle Tool  

Salah satu keunggulan CorelDRAW adalah pembuatanSalah satu keunggulan CorelDRAW adalah pembuatan

Round Corner dengan radius berbeda tiap sudutnya. DiRound Corner dengan radius berbeda tiap sudutnya. Di

property bar Rectangle ini hal iproperty bar Rectangle ini hal itu dapat dengan mudahtu dapat dengan mudah

dilakukan.dilakukan.

Property Bar Ellipse ToolProperty Bar Ellipse Tool

Ini juga merupakan salah satu Ini juga merupakan salah satu keunggulan CorelDRAW dalam pembuatan objek lingkaran dengan gayakeunggulan CorelDRAW dalam pembuatan objek lingkaran dengan gaya

berbeda dengan mudah seperti lingkaran utuh, berbentuk pie dan juga berbeda dengan mudah seperti lingkaran utuh, berbentuk pie dan juga lingkaran putus.lingkaran putus.

Property Bar Polygon, Star, Complex Star, Graph Paper & Spiral ToolProperty Bar Polygon, Star, Complex Star, Graph Paper & Spiral Tool

Property bar yang mengatur semua settingan Property bar yang mengatur semua settingan untuk objek berbentuk polygon, star, complex star, graphuntuk objek berbentuk polygon, star, complex star, graph
paper & spiral.paper & spiral.

Property Bar Basic ShapesProperty Bar Basic Shapes  

Cara termudah menggambar suatu bentuk sederhana di Cara termudah menggambar suatu bentuk sederhana di CorelDRAWCorelDRAW

adalah dengan menggunakan Basic Shape. Model-model shape dapatadalah dengan menggunakan Basic Shape. Model-model shape dapat

diakses lewat property bar-nya. Lihat gambar di samping.diakses lewat property bar-nya. Lihat gambar di samping.

Untuk Arrow Shape, Flowchart Shape, Banner Shape & CalloUntuk Arrow Shape, Flowchart Shape, Banner Shape & Callout Shapeut Shape

dapat dilakukan dengan cara yang sama.dapat dilakukan dengan cara yang sama.  

Property Bar Text ToolProperty Bar Text Tool  

Property bar yang mengatur atribut-atribuProperty bar yang mengatur atribut-atribut teks t teks seperti jenis, style dan ukuran font atau juga peseperti jenis, style dan ukuran font atau juga perataanrataan

paragraf.paragraf.
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Latihan 1Latihan 1

Membuat Objek-Objek SederhanaMembuat Objek-Objek Sederhana

1.1.   Buatlah objek-objek seperti di bawah ini menggunakan fasilitas Basic Shapes.Buatlah objek-objek seperti di bawah ini menggunakan fasilitas Basic Shapes.

2.2.   Buatlah beberapa garis sederhana denBuatlah beberapa garis sederhana dengan ketebalan dan style gan ketebalan dan style garis yang berbedagaris yang berbeda

menggunakanmenggunakan FreehandFreehand,, BezierBezier dan dan PenPen  Tool. Tool.

3.3.   Buatlah objekBuatlah objek RectangleRectangle,, ElipseElipse,, Star Star ,, Complex Star Complex Star ,, PolygonPolygon dan dan SpiralSpiral tanpa & menggunakan tanpa & menggunakan

kombinasi tombolkombinasi tombol CtrlCtrl dan dan Ctrl+ShiftCtrl+Shift..

4.4.   Berilah warna objek-objek pada soal no. 3 denganBerilah warna objek-objek pada soal no. 3 dengan Uniform FillUniform Fill (warna solid/blok) dan (warna solid/blok) dan FountainFountain

FillFill  (gradasi).  (gradasi).

5.5.   Mini Project.Mini Project.

Buatlah sebuah objek Rectangle & teks yang terdiri dari teks dan pragraf seperti contoh berikut :Buatlah sebuah objek Rectangle & teks yang terdiri dari teks dan pragraf seperti contoh berikut :
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Menggambar BentukMenggambar Bentuk

Mempersiapkan Area KerjaMempersiapkan Area Kerja

Sebelum berkreasi, ada baiknya mengatur dulu ukuran halaman atau dokumen baru. Halaman adalahSebelum berkreasi, ada baiknya mengatur dulu ukuran halaman atau dokumen baru. Halaman adalah
area tempat objek yanarea tempat objek yang akan dicetak g akan dicetak juga tempat kita mengjuga tempat kita menggambar sedangkan gambar sedangkan area di area di sekelilingsekeliling

halaman kita boleh menempatkan corat-coret objek. halaman kita boleh menempatkan corat-coret objek. Lihat gambar di atas untuk acuan.Lihat gambar di atas untuk acuan.

Membuat ObjekMembuat Objek
Setiap objek yang dibuat akan terdiri dari area isi ( Setiap objek yang dibuat akan terdiri dari area isi (  fill fill )  ) dan dan garis garis luar luar ( ( outlineoutline ).  ). Dalam Dalam kondisi kondisi defaultdefault

objek terdiri dari isi warna transparan dan garis luar warna hitam. Dalam pembuatan objek ini berlakuobjek terdiri dari isi warna transparan dan garis luar warna hitam. Dalam pembuatan objek ini berlaku

fungsi-fungsi mouse (klik, drag & drop) sertafungsi-fungsi mouse (klik, drag & drop) serta kombinasikombinasi antara fungsi mouse dengan tombol antara fungsi mouse dengan tombol CtrlCtrl,, AltAlt   

dandan ShiftShift..

   Untuk membuat objek yang presisi sama sisi tekanUntuk membuat objek yang presisi sama sisi tekan CtrlCtrl ketika drag. (berlaku untuk Rectangle, ketika drag. (berlaku untuk Rectangle,

Ellipse, Star, Complex Star, Spiral & Ellipse, Star, Complex Star, Spiral & Polygon).Polygon).

  
Untuk membuat objek dari titik tengah, tekanUntuk membuat objek dari titik tengah, tekan ShiftShift ketika membuat objek. ketika membuat objek.

    Jika  Jika telah telah selesai selesai membuat membuat sebuahsebuah Rectangle, Ellipse, Star, Complex Star, Spiral & PolygonRectangle, Ellipse, Star, Complex Star, Spiral & Polygon,,

cobalah bereksperimen dengancobalah bereksperimen dengan Shape Tool (F10)Shape Tool (F10)  untuk   untuk mendapatkan bentuk mendapatkan bentuk lain lain yang lebihyang lebih

variatif.variatif.

P E N T I N GP E N T I N G

Untuk mendapatkan bentuk objek yang diinginkan, ketika membuat objek menggunakanUntuk mendapatkan bentuk objek yang diinginkan, ketika membuat objek menggunakan

tool bartool bar jangan lupajangan lupa untuk mengatur masing-masing settingan lewat untuk mengatur masing-masing settingan lewat Property Bar Property Bar   dari  dari

masing-masingmasing-masing tool bar tool bar    seperti yang sudah seperti yang sudah dijelaskan pada dijelaskan pada bab sebelumnya.bab sebelumnya.

   KotakKotak

oo
   Klik ikonKlik ikon Rectangle Rectangle tool tool ..  

oo   Klik lalu Klik lalu tahan – geser tahan – geser – lepaskan– lepaskan (pada area(pada area

canvas).canvas).

oo    Jika ingin membuat Jika ingin membuat round-cornerround-corner, tekan, tekan F10F10   lalu  lalu

dragdrag  salah satu kotak hitam (lihat gambar di  salah satu kotak hitam (lihat gambar di

samping).samping).  

   LingkaranLingkaran

oo   Klik ikonKlik ikon Ellipse Ellipse tool tool ..  

oo  
Klik lalu Klik lalu tahan – getahan – geser – lepaskanser – lepaskan (pada area(pada areacanvas)canvas)
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   PolygonPolygon

oo   Klik ikonKlik ikon Polygon Polygon tool tool ..  

oo   Klik lalu Klik lalu tahan – getahan – geser – lepaskanser – lepaskan (pada area(pada area

canvas)canvas)  

   SpiralSpiral

oo   Klik dan tahan ikonKlik dan tahan ikon Polygon toolPolygon tool sampai munculsampai muncul

SpiralSpiral ..

oo
   Klik lalu Klik lalu tahan – getahan – geser – lepser – lepaskanaskan (pada area(pada area

canvas)canvas)

   StarStar

oo   Klik dan tahan ikonKlik dan tahan ikon Polygon toolPolygon tool sampai munculsampai muncul

StarStar ..  

oo   Klik lalu Klik lalu tahan – getahan – geser – lepaskanser – lepaskan (pada area(pada area

canvas)canvas)

   Basic ShapeBasic Shape

oo   Klik ikonKlik ikon Basic Basic Shape Shape ..  

oo   Klik lalu Klik lalu tahan – getahan – geser – lepaskanser – lepaskan (pada area(pada area

canvas)canvas)

   KurvaKurva

oo   Klik ikonKlik ikon Freehand, Bezier atau Pen.Freehand, Bezier atau Pen.  

oo   Klik beberapa kali pada area kerja. Khusus PenKlik beberapa kali pada area kerja. Khusus Pen

klik dua kali untuk mengakhiri kurva.klik dua kali untuk mengakhiri kurva.  

oo   Klik pada awal kurva dibuatKlik pada awal kurva dibuat jika ingin menutup jika ingin menutup

kurva (membuat kurva tertutup).kurva (membuat kurva tertutup).  

Untuk dapat merubah kurva ke bentuk Untuk dapat merubah kurva ke bentuk yang kita inginkan, jangan lupakanyang kita inginkan, jangan lupakan Property BarProperty Bar dari dari ShapeShape

ToolTool!!

Berikut penjelasannya :Berikut penjelasannya :

••   Make Node SymmetricalMake Node Symmetrical: kotak kanan ditarik kotak kiri : kotak kanan ditarik kotak kiri ikut bergerak secara simetrik.ikut bergerak secara simetrik.
Atau juga bisa Atau juga bisa membuat node bersudut tumpul.membuat node bersudut tumpul.

••   Make Node SmoothMake Node Smooth: kotak kanan ditarik kotak kiri tidak i: kotak kanan ditarik kotak kiri tidak ikut bergerak, tapi jika kotakkut bergerak, tapi jika kotak
kanan ditarik ke atas dan kebawah kotak kiri kanan ditarik ke atas dan kebawah kotak kiri ikut bergerak, begitu juga sebaliknya.ikut bergerak, begitu juga sebaliknya.
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••   Make Node A CuspMake Node A Cusp: Kotak kanan ditarik ke kanan/kiri atas/bawah kotak : Kotak kanan ditarik ke kanan/kiri atas/bawah kotak sebelahnyasebelahnya
tidak terpengaruh. Atau bisa juga membuat tidak terpengaruh. Atau bisa juga membuat node bersudut tajam.node bersudut tajam.

••   Convert Line to CurveConvert Line to Curve: merubah garis kedalam bentuk kurva sehingga garisnya bisa: merubah garis kedalam bentuk kurva sehingga garisnya bisa
diubah/edit menggunakandiubah/edit menggunakan Shape ToolShape Tool ..

••   Convert Curve to LineConvert Curve to Line: merubah kurva kembali kebentuk garis.: merubah kurva kembali kebentuk garis.

••   Break Curve/ Join Two NodesBreak Curve/ Join Two Nodes: memutuskan simpul/Node atau menyambungkan: memutuskan simpul/Node atau menyambungkan
dua simpul/Node.dua simpul/Node.

••   Add Node / Delete NodeAdd Node / Delete Node: Menambah Simpul baru atau : Menambah Simpul baru atau menghapus Simpul.menghapus Simpul.

Berikut ini adalah contoh penerapan pembuatan objek yang mBerikut ini adalah contoh penerapan pembuatan objek yang melibatkan peranelibatkan peran Property BarProperty Bar  ShapeShape
Tool.Tool.  

   Teks & Paragraf (Text Frame)Teks & Paragraf (Text Frame)

oo   Klik ikonKlik ikon Text Tool.Text Tool.  

oo   Klik pada area kerja. Lalu ketikkan teks yangKlik pada area kerja. Lalu ketikkan teks yang

diinginkan.diinginkan.  

oo   Klik lalu drag pada area kerja untuk membuat 1Klik lalu drag pada area kerja untuk membuat 1

paragraf teks. Ukuran paragraf dapat diaturparagraf teks. Ukuran paragraf dapat diatur

seperti mengatur bentukseperti mengatur bentuk RectangleRectangle..  

oo   Perataan teks ( Perataan teks ( Left, Center, Right Left, Center, Right  & & EvenEven ) dapat ) dapat

diatur diatur melalui melalui icon icon di di Preperty Preperty Bar Bar Text Text Tool.Tool.  

Salah satu contoh bentuk paragraf teks yang bentuknyaSalah satu contoh bentuk paragraf teks yang bentuknya

divariasikan dan dipecah menjadi 3 paragraf.divariasikan dan dipecah menjadi 3 paragraf.

Contoh teks 1 baris non-paragraf :Contoh teks 1 baris non-paragraf :

Contoh teks Text Frame / berparagraf :Contoh teks Text Frame / berparagraf :
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Mentransformasi ObjekMentransformasi Objek
Setelah belajar bagaimana caranya membuat objek Setelah belajar bagaimana caranya membuat objek (menggambar) maka tahap selanjutnya adalah(menggambar) maka tahap selanjutnya adalah

bagaimanabagaimana  objek-objek yang telah kita objek-objek yang telah kita gambar tersebut ditransformasikan. Seperti digeser, diperbesar-gambar tersebut ditransformasikan. Seperti digeser, diperbesar-

perkecil bentuknya, diputar (rotasi), dimiringkan dan direfleksikan (efek cermin).perkecil bentuknya, diputar (rotasi), dimiringkan dan direfleksikan (efek cermin).  

   Menggeser ObjekMenggeser Objek

oo   KlikKlik Pick ToolPick Tool   sampai sampai muncul muncul 88

kotak hitam kecil di sekelilingkotak hitam kecil di sekeliling

objek.objek.
oo   Pilih objek yang ingin digeser.Pilih objek yang ingin digeser.

oo   Lalu drag ke posisi yag diinginkan.Lalu drag ke posisi yag diinginkan.

oo   Bila menginginkan posisi baruBila menginginkan posisi baru

yang sejajar dengan yang lama,yang sejajar dengan yang lama,

tahan Ctrl ketika drag.tahan Ctrl ketika drag.

oo   Bila ingin menduplikasi objekBila ingin menduplikasi objek

ketika menggeser, klik kananketika menggeser, klik kanan

selesai drag.selesai drag.

TIPS :TIPS :  

 Jika ingin menduplikasi objek den Jika ingin menduplikasi objek dengan nilai step tertentu,gan nilai step tertentu,

tekantekan Ctrl+DCtrl+D lalu masukkan nilai  lalu masukkan nilai pergeserannya.pergeserannya.

Misalnya, ingin menduplikasi objek setiap 5 mm.Misalnya, ingin menduplikasi objek setiap 5 mm.

   Merubah dimensi objekMerubah dimensi objek

oo   Pilih objek yang ingin dirubahPilih objek yang ingin dirubah

dimensinya.dimensinya.

oo
   Drag salah satu dari 8 kotak Drag salah satu dari 8 kotak hitamhitam

sampai ukuran yang diinginkansampai ukuran yang diinginkan

terpenuhi.terpenuhi.

oo   Bila ingin menduplikasi objekBila ingin menduplikasi objek

ketika merubah dimensinya, klikketika merubah dimensinya, klik

kanan selesai drag.kanan selesai drag.

TIPS :TIPS :  

 Jika ingin merubah dimensi objek d Jika ingin merubah dimensi objek dapat juga denganapat juga dengan

menggunakan menggunakan tool tool Free Free Transform Transform Tool Tool di di tool tool box.box.

   Memutar ObjekMemutar Objek

oo   Pilih objek yang ingin putar.Pilih objek yang ingin putar.

oo   Klik sekali lagi sehingga 8 kotakKlik sekali lagi sehingga 8 kotak

hitam berubah menjadi gambarhitam berubah menjadi gambar

panah berputar.panah berputar.

oo   Drag sampai Drag sampai posisi putaran posisi putaran yangyang

diinginkan terpenuhi.diinginkan terpenuhi.

oo   Bila ingin menduplikasi objekBila ingin menduplikasi objek

ketika memutarnya, klik kananketika memutarnya, klik kanan

selesai drag.selesai drag.

TIPS :TIPS :  

 Jika ingin memutar objek dapat juga den Jika ingin memutar objek dapat juga dengan menggunakangan menggunakan

tool tool Free Free Transform Transform Tool Tool di di tool tool box. box. Titik Titik pusatpusat

putaran akan sangat bergantung dari di mana kita pertamaputaran akan sangat bergantung dari di mana kita pertama

kali mengklik objek.kali mengklik objek.

   Memiringkan ObjekMemiringkan Objek

oo   Pilih objek yang ingin miringkan.Pilih objek yang ingin miringkan.

oo   Klik sekali lagi sehingga 8 kotakKlik sekali lagi sehingga 8 kotak

hitam berubah menjadi gambarhitam berubah menjadi gambar

panah berputar.panah berputar.

oo   Drag pada panahDrag pada panah

horizontal/vertical.horizontal/vertical. Tool Free Transform dapat juga Tool Free Transform dapat juga digunakan untukdigunakan untuk
memiringkan objek. Tekan Ctrl agar miring sejajarmemiringkan objek. Tekan Ctrl agar miring sejajar

horizontal/vetikal.horizontal/vetikal.



  

   Menggambar Grafik Vektor Dengan CorelDRAW X4Menggambar Grafik Vektor Dengan CorelDRAW X4
  

   1616

   Merefleksikan ObjekMerefleksikan Objek

oo   Pilih objek yang ingin dicerminkan.Pilih objek yang ingin dicerminkan.

oo   Klik Klik icon icon ..

TIPS :TIPS :  

 Jika ingin merefleksikan objek dapat juga de Jika ingin merefleksikan objek dapat juga denganngan

menggunakan menggunakan tool tool Free Free Transform Transform Tool Tool di di tool tool box.box.

Titik pusat cermin Titik pusat cermin akan sangat bergantunakan sangat bergantung dari di manag dari di mana

kita pertama kali mengklik objek.kita pertama kali mengklik objek.

Prioritas Urutan ObjekPrioritas Urutan Objek

Pengertian proritas objek di sini adalah objek mana yang akan muncul paling atas atau bawah jikaPengertian proritas objek di sini adalah objek mana yang akan muncul paling atas atau bawah jika

terjadi penumpukan beberapa objek. Jika kita membuat banyak objek maka objek yang pertama kaliterjadi penumpukan beberapa objek. Jika kita membuat banyak objek maka objek yang pertama kali

dibuat akan berada pada tumpukan terbawah/terakhir sedangkan objek yang terakhir dibuat akandibuat akan berada pada tumpukan terbawah/terakhir sedangkan objek yang terakhir dibuat akan

berada pada tumpukan teratas. Jika kita menginginkan objek yang kita buat muncul paling atas atauberada pada tumpukan teratas. Jika kita menginginkan objek yang kita buat muncul paling atas atau

paling bawah atau mungkin bergeser satu paling bawah atau mungkin bergeser satu tingkatan maka diberlakukantingkatan maka diberlakukan Stacking Order/urutan objekStacking Order/urutan objek..

Cara mudah merubah urutan objek adalah :Cara mudah merubah urutan objek adalah :

   Klik objek lalu tekanKlik objek lalu tekan Ctrl+Page DownCtrl+Page Down jika jika

ingin memindingin memindahkan objek ke ahkan objek ke belakang belakang atauatau

   tekantekan Ctrl+Pg UpCtrl+Pg Up jika ingin memindahkan jika ingin memindahkan

objek ke depan.objek ke depan.

 Jika klik  Jika klik kanan pada objek kanan pada objek lalu pilihlalu pilih OrderOrder, akan ada, akan ada

beberapa pilihan urutan objek :beberapa pilihan urutan objek :

Namun jika kita tersesat dalam ribuan objek yang saling bertumpuk satu sama lain maka cara mengaturNamun jika kita tersesat dalam ribuan objek yang saling bertumpuk satu sama lain maka cara mengatur

objek yang paling mudah adalah dengan menggunakanobjek yang paling mudah adalah dengan menggunakan LayerLayer. Layer dapat diakses lewat menu. Layer dapat diakses lewat menu

Windows -> Dockers -> Object ManagerWindows -> Dockers -> Object Manager. Berikut ini contoh Object Manager yang menghandle ratusan. Berikut ini contoh Object Manager yang menghandle ratusan

objek. Objek-objek tersebut terbagi ke dalam objek. Objek-objek tersebut terbagi ke dalam beberapa layer untuk memudahkan pengaturan.Kita dapatbeberapa layer untuk memudahkan pengaturan.Kita dapat

fokus ke suatu layer sehingga objek-objek di dalamnya tidak mengganggu objek-objek di layer yangfokus ke suatu layer sehingga objek-objek di dalamnya tidak mengganggu objek-objek di layer yang
lain.lain.
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PrinsipPrinsip Layer Layer  adalah sama halnya seperti lapisan adalah sama halnya seperti lapisan

plastik transparan. Dengan menggunakan sistemplastik transparan. Dengan menggunakan sistem

Layer maka beberapa objek dapat dikelompokkanLayer maka beberapa objek dapat dikelompokkan

menjadi satu dan menempati satu lapisan/layer.menjadi satu dan menempati satu lapisan/layer.

Masing-masing kelompok dipisahkan ke dalamMasing-masing kelompok dipisahkan ke dalam

layer yang berbeda.layer yang berbeda.

Tujuannya :Tujuannya :

1.1.   Agar tidak mengganggu objek lainnya ketikaAgar tidak mengganggu objek lainnya ketika
sedang diedit.sedang diedit.

2.2.   Bekerja lebih fokus hanya pada objek yangBekerja lebih fokus hanya pada objek yang

diedit.diedit.

3.3.   Semua objek lebih teratur dan terorganisir.Semua objek lebih teratur dan terorganisir.

4.4.   Design terlihat lebih profesional.Design terlihat lebih profesional.

Perataan ObjekPerataan Objek

Masih dalam pembahasan manajemen atau pengaturan objek, kali ini kita akan mengatur perataanMasih dalam pembahasan manajemen atau pengaturan objek, kali ini kita akan mengatur perataan

objek agar terlihat rapi. Perataan atauobjek agar terlihat rapi. Perataan atau alignment alignment   biasanya terjadi jika kita menggunakan satu objek  biasanya terjadi jika kita menggunakan satu objek

sebagai tolok ukur perataan objek-objek lainnya.sebagai tolok ukur perataan objek-objek lainnya.

Perataan objek terdiri dariPerataan objek terdiri dari Rata KananRata Kanan (  ( RR ), ), KiriKiri (  ( LL ), ), TengahTengah (  ( CC ), ), AtasAtas (  ( TT ) dan ) dan BawahBawah (  ( BB ). ).

Salah satu syarat perataan objek-objek adalah adaSalah satu syarat perataan objek-objek adalah ada

satu objek yang menjadi tolok ukur perataansatu objek yang menjadi tolok ukur perataan

sehingga objek-objek yang lain dapatsehingga objek-objek yang lain dapat

mengikutinya. Objek yang terakhir diklik akanmengikutinya. Objek yang terakhir diklik akan

menjadi tolok ukur perataan.menjadi tolok ukur perataan.

Cara meratakan objek:Cara meratakan objek:

Pilih Pilih beberapa beberapa objek, objek, lalu lalu klik klik icon icon didi

Property Bar Property Bar , kotak dialog, kotak dialog Align & DistributeAlign & Distribute  

akan muncul. Pilih perataan yang diinginkan.akan muncul. Pilih perataan yang diinginkan.

Contoh objek-objek rata kanan :Contoh objek-objek rata kanan :
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Membentuk Ulang ObjekMembentuk Ulang Objek

Sering kita menghendaki objek-objek yang sudah ada ingin dibentuk ulang sehingga menghasilkanSering kita menghendaki objek-objek yang sudah ada ingin dibentuk ulang sehingga menghasilkan

objek baru namun dengan bentuk yang kurang lebih sama alias tidak jauh berbeda dengan aslinya.objek baru namun dengan bentuk yang kurang lebih sama alias tidak jauh berbeda dengan aslinya.

Di CorelDRAW kita dapat membentuk ulang objek-objek yang sDi CorelDRAW kita dapat membentuk ulang objek-objek yang sudah ada dengan cara :udah ada dengan cara :

   WeldWeld (mengelas/menyambung objek) (mengelas/menyambung objek)

   TrimTrim (memotong mengikuti bentuk objek pemotong) (memotong mengikuti bentuk objek pemotong)

   IntersectIntersect (mendapatkan gambar  (mendapatkan gambar perpotongannya)perpotongannya)

   SimplifySimplify (gambar tumpukan teratas memotong gambar di  (gambar tumpukan teratas memotong gambar di bawahnya)bawahnya)

   Front Minus BackFront Minus Back dandan Back Minus Front Back Minus Front

  

   Membuat objek baru berdasarkan outline gabungan dari kedua buah Membuat objek baru berdasarkan outline gabungan dari kedua buah objek.objek.

Selain dengan cara di atas, pengaturan objek yang biasa dilakukan adalah dengan mengelompokkanSelain dengan cara di atas, pengaturan objek yang biasa dilakukan adalah dengan mengelompokkan

objek atauobjek atau GrouppingGroupping. Caranya, pilih/seleksi beberapa objek lalu tekan. Caranya, pilih/seleksi beberapa objek lalu tekan Ctrl+GCtrl+G. Pengelompokkan. Pengelompokkan

berguna untuk memudahkan pengeditan secara serentak ke beberapa buah objek gambar. Jika inginberguna untuk memudahkan pengeditan secara serentak ke beberapa buah objek gambar. Jika ingin

menguraikan menguraikan objek yang digobjek yang digroup cukup roup cukup tekantekan Ctrl+UCtrl+U pada objek yang  pada objek yang tergroup tersebut.tergroup tersebut.
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 Alat-Alat Bantu Menggambar Alat-Alat Bantu Menggambar

Suatu artwork yang hebat merupakan sebuah hasil proses yang panjang. Meliputi proses kreatif mulaiSuatu artwork yang hebat merupakan sebuah hasil proses yang panjang. Meliputi proses kreatif mulai

dari pencarian ide, sketsa, sampai final dari pencarian ide, sketsa, sampai final artwork. Selain tool-tool atau alat-alat artwork. Selain tool-tool atau alat-alat yang sudah disebutkan diyang sudah disebutkan di

atas, masih ada lagi beberapa alat baatas, masih ada lagi beberapa alat bantu menggambar di CorelDRAW.ntu menggambar di CorelDRAW.

Mereka adalah :Mereka adalah :

   RulerRuler

Satuan Ruler atau penggaris dapat kita tentukan lewat Property Bar Pick Tool. Centimeter,Satuan Ruler atau penggaris dapat kita tentukan lewat Property Bar Pick Tool. Centimeter,
milimeter, meter, pixel, point dan lain-lain.milimeter, meter, pixel, point dan lain-lain.

Cara menampilkannya/menyembunyikanCara menampilkannya/menyembunyikannya cukup masuk nya cukup masuk keke View -> RulerView -> Ruler..

   GridGrid

Bermanfaat agar objek-objek di area kerja kita lebih teratur. Teruatama untuk Alignment atauBermanfaat agar objek-objek di area kerja kita lebih teratur. Teruatama untuk Alignment atau
perataan. Cara menampilkannya/menyembunyikannya cukup masuk keperataan. Cara menampilkannya/menyembunyikannya cukup masuk ke View -> GridView -> Grid..

   GuidelinesGuidelines

Tool yang sangat vital karena dengan guideline semua objek dapat diatur menurut garis panduTool yang sangat vital karena dengan guideline semua objek dapat diatur menurut garis pandu

yang telah kita tentukan sebelumnya. Cara membuatnya cukup drag Ruler/penggaris ke areayang telah kita tentukan sebelumnya. Cara membuatnya cukup drag Ruler/penggaris ke area

kerja kita. kerja kita. Menampilkannya/menyembuMenampilkannya/menyembunyikannya cukup masuk kenyikannya cukup masuk ke View -> GuidlinesView -> Guidlines..
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Latihan 2Latihan 2

Membuat Objek-Objek SederhanaMembuat Objek-Objek Sederhana

1.1.   Membuat logo sederhana.Membuat logo sederhana.

Buatlah teksBuatlah teks KREATIKA MAGAZINEKREATIKA MAGAZINE, gambar kotak persegi panjang warna hitam di bawah teks, gambar kotak persegi panjang warna hitam di bawah teks

KREATIKA.KREATIKA.

Tool Tool yang yang digunakan digunakan adalah adalah Rectangle Rectangle Tool Tool (F6) (F6) dan dan Text Text Tool Tool (F8) (F8) ..

2.2.   Membuat Membuat daun daun secara secara sederhana sederhana menggunakan menggunakan Bezier Bezier Tool Tool ..

oo   Klik mulai dari titik 1, 2 lalu diakhiri di titik 3.Klik mulai dari titik 1, 2 lalu diakhiri di titik 3.

oo   GunakanGunakan Shape ToolShape Tool   lalu lalu klik klik salah salah satu satu titik titik lalu lalu klik klik iconicon Convert Line To CurveConvert Line To Curve  

untuk membuat garis menjadi lengkungan.untuk membuat garis menjadi lengkungan.

oo   Lalu warnai daun tersebut.Lalu warnai daun tersebut.

3.3.   Membuat stempel menggunakan fasilitasMembuat stempel menggunakan fasilitas WeldWeld   ..
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4.4.   Membuat logoMembuat logo TOYOTATOYOTA menggunakanmenggunakan  fasilitas Combinefasilitas Combine .. Setelah selesai, ratakan ketigaSetelah selesai, ratakan ketiga

objek tersebut menjadi rata tengah secara vertikal.objek tersebut menjadi rata tengah secara vertikal.

5.5.   Membuat teks mengikuti alur sebuah kurva Membuat teks mengikuti alur sebuah kurva (path).(path).

oo   Buatlah beberapa ‘potong’ teks.Buatlah beberapa ‘potong’ teks.

oo   Buat juga sebuah lingkaran. Teks aBuat juga sebuah lingkaran. Teks akan mengikuti alur lingkaran.kan mengikuti alur lingkaran.

oo   Klik teks yang akan dirubah alurnya lalu klikKlik teks yang akan dirubah alurnya lalu klik Text -> Fit Text To PathText -> Fit Text To Path..

oo   Arahkan kursor mouse ke sebuah lingkaran Arahkan kursor mouse ke sebuah lingkaran atau kurva/path yang dituju.atau kurva/path yang dituju.
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Mewarnai BentukMewarnai Bentuk
Setelah kita berkenalan dengan tool-tool di CorelDRAW dan telah mempelajari bagaimana caranyaSetelah kita berkenalan dengan tool-tool di CorelDRAW dan telah mempelajari bagaimana caranya

menggambar di CorelDRAW, sekarang kita akan mempelajari bagaimana caranya mewarnai objek-objekmenggambar di CorelDRAW, sekarang kita akan mempelajari bagaimana caranya mewarnai objek-objek

yang telah kita buat.yang telah kita buat.

Warna terdiri dari 2 jenis yaituWarna terdiri dari 2 jenis yaitu
   Warna solidWarna solid atau warna blok. atau warna blok.

Di CorelDRAW warna solid/blok dikenal dengan namaDi CorelDRAW warna solid/blok dikenal dengan nama Uniform Fill.Uniform Fill.

   Warna gradasiWarna gradasi  (transisi suatu warna ke warna yang lain)  (transisi suatu warna ke warna yang lain)

Di CorelDRAW gradasi dikenal dengan namaDi CorelDRAW gradasi dikenal dengan nama Fountain Fill.Fountain Fill.  

Sedangkan menurut letaknya ada 2 jenis warna, yaitu :Sedangkan menurut letaknya ada 2 jenis warna, yaitu :

   Warna FillWarna Fill (  ( Uniform FillUniform Fill ) )

Warna yang mengisi area objek atau kurva tertutup. Kurva atau objek terbuka tidak dapat diberiWarna yang mengisi area objek atau kurva tertutup. Kurva atau objek terbuka tidak dapat diberi

warna fill.warna fill.

   Warna Outline / LineWarna Outline / Line

Warna yang berada di sekeliling objek.Warna yang berada di sekeliling objek.
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Ada berbagai macam cara mewarnai objek di CorelDRAW namun ada 2 cara yang termudah yaitu :Ada berbagai macam cara mewarnai objek di CorelDRAW namun ada 2 cara yang termudah yaitu :

   Melalui Color DockerMelalui Color Docker..

Cukup klik objek yang akan diberi warna kemudian klik salah satu warnaCukup klik objek yang akan diberi warna kemudian klik salah satu warna

yang dikehendaki diyang dikehendaki di Color DockerColor Docker. Contoh Color Docker lihat gambar di. Contoh Color Docker lihat gambar di

samping. Default warna yang tersedia adalah warnasamping. Default warna yang tersedia adalah warna CMYKCMYK. Namun kita. Namun kita

masih dapat memilih skema warna yang lain sepertimasih dapat memilih skema warna yang lain seperti RGBRGB,, PANTONEPANTONE dan dan

lain lain.lain lain.

Mewarnai fill objek cukup klik pada warna yang dikehendaki,Mewarnai fill objek cukup klik pada warna yang dikehendaki,

namun jika ingin mewarnai Outline klik kanan pada warnanamun jika ingin mewarnai Outline klik kanan pada warna

yang dikehendaki.yang dikehendaki.

   Melalui Kotak DialogMelalui Kotak Dialog..

Klik objek yang akan diberi warna lalu klik iconKlik objek yang akan diberi warna lalu klik icon

pada tool bar sehingga muncul pilihanpada tool bar sehingga muncul pilihan

Uniform Fill, Fountain Fill dllUniform Fill, Fountain Fill dll. Pada pilihan. Pada pilihan

Uniform FillUniform Fill  pilih warna yang dikehendaki  pilih warna yang dikehendaki

menurutmenurut ModelsModels,, MixersMixers atau atau PalettesPalettes. Lalu klik. Lalu klik

Ok.Ok.PadaPada Fountain FillFountain Fill, pilh tipe gradasi baik itu, pilh tipe gradasi baik itu

Linear Linear ,, RadialRadial,, ConicalConical atau atau SquareSquare..
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Cara termudah untuk menghapus warna pada suatu objek, baik itu warna solid atau gradasi adalahCara termudah untuk menghapus warna pada suatu objek, baik itu warna solid atau gradasi adalah

dengan dengan klik klik pada pada icon icon yang yang terdapat terdapat pada pada Color Color Docker. Docker. Sedangkan Sedangkan untuk untuk menghapus menghapus warnawarna

outline cukup klik kanan pada icon tadi.outline cukup klik kanan pada icon tadi.

Mewarnai Objek Dengan GradasiMewarnai Objek Dengan Gradasi

Warna gradasi adalah transisi dari suatu warna ke warna yang lain. Gradasi juga dapat memberikanWarna gradasi adalah transisi dari suatu warna ke warna yang lain. Gradasi juga dapat memberikan
sensasi tersendiri pada objek yang diwarnai karena dapat menimbulkan kesan dimensi atau adanyasensasi tersendiri pada objek yang diwarnai karena dapat menimbulkan kesan dimensi atau adanya

ruang yang terdapat pada suatu objek.ruang yang terdapat pada suatu objek.

A. Berikut ini langkah-langkah mewarnai objek dengan warna gradasi menggunakan kotak dialogA. Berikut ini langkah-langkah mewarnai objek dengan warna gradasi menggunakan kotak dialog

Fountain FillFountain Fill..

1.1.   Klik text toolKlik text tool

2.2.   Ketikkan kalimatKetikkan kalimat MULTIMEDIAMULTIMEDIA

3.3.   Masih dalam keadaan terseleksi, teksMasih dalam keadaan terseleksi, teks MULTIMEDIAMULTIMEDIA kita jadikan kita jadikan CurveCurve.... Tekan Ctrl+QTekan Ctrl+Q. Beri. Beri
warna fill dan outline dengan Black 100 % (C=0, M=0, Y=0, K=100).warna fill dan outline dengan Black 100 % (C=0, M=0, Y=0, K=100).

4.4.   Tekan F11 sehingga terbuka kotak dialogTekan F11 sehingga terbuka kotak dialog Fountain FillFountain Fill (lihat gambar halaman sebelumnya).(lihat gambar halaman sebelumnya).

Pilih type : Linear, angle = 90Pilih type : Linear, angle = 90
00
, , Edge Pad = Edge Pad = 0 lalu buat skema warna 0 lalu buat skema warna pada Color Blend pada Color Blend = = CustomCustom

seperti ini…seperti ini…

Untuk menambah warna-warna baru di antara kotak hitam dan Untuk menambah warna-warna baru di antara kotak hitam dan putih cukuk double klik di putih cukuk double klik di antaraantara

kedua kotak tersebut. Masing-masing segitiga kedua kotak tersebut. Masing-masing segitiga mengandung satu warna.mengandung satu warna.  

5.5.   Klik Ok. Hasil akhir seharusnya seperti gambar di bawah ini.Klik Ok. Hasil akhir seharusnya seperti gambar di bawah ini.

6.6.    Jika  Jika suatu suatu objek objek sudah sudah pernah pernah diisi diisi warna warna gradasi gradasi lalu lalu ingin ingin diedit diedit kembali kembali gradasinya, gradasinya, cukupcukup

dengan klik icondengan klik icon Interactive Fill ToolInteractive Fill Tool   di di tool tool bar bar lalu lalu pilihpilih LinearLinear. Kemudia kursor mouse. Kemudia kursor mouse

akan berubah menjadi slider bertanda panah tempat kita mengatur setting warna gradasi.akan berubah menjadi slider bertanda panah tempat kita mengatur setting warna gradasi.
Di property bar-nya pun ada parameter yang dapat kita isi, mirip dengan parameter yang ada diDi property bar-nya pun ada parameter yang dapat kita isi, mirip dengan parameter yang ada di

kotak dialog Fountain Fill.kotak dialog Fountain Fill.
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Property Bar Interactive Fill ToolProperty Bar Interactive Fill Tool

Jenis –Jenis – jenis Grjenis Gradasi ( Founadasi ( Fountain Fill )tain Fill )

  

Linear RadialLinear Radial

Conical SquareConical Square

B. Cara membuat gradasi B. Cara membuat gradasi menggunakanmenggunakan Interactive Fill ToolInteractive Fill Tool   ..

1.1.   Buat sebuah objek.Buat sebuah objek.

2.2.   Klik Klik icon icon Interactive Interactive Fill Fill Tool Tool . . Property Property Bar Bar yang yang bersangkutan bersangkutan akan akan muncul muncul (lihat (lihat gambargambar

paling atas halaman ini).paling atas halaman ini).

3.3.   Klik Linear pada pilihan Fill Type.Klik Linear pada pilihan Fill Type.

4.4.   Slider gradasi akan muncul. Jika slider ini muncul berarti kita bebasSlider gradasi akan muncul. Jika slider ini muncul berarti kita bebas

menentukan bentuk dan arah gradasi sesuai menentukan bentuk dan arah gradasi sesuai keinginan kita.keinginan kita.



  

   Menggambar Grafik Vektor Dengan CorelDRAW X4Menggambar Grafik Vektor Dengan CorelDRAW X4
  

   2626

5.5.   Ganti warna gradasi (Fountain Fill) dengan merah dan hijau.Ganti warna gradasi (Fountain Fill) dengan merah dan hijau.

Prinsip dasar gradasi = Transisi dari warna apa ke Prinsip dasar gradasi = Transisi dari warna apa ke warna apa.warna apa.

6.6.   Drag kotak warna pada slider ke mana saja Drag kotak warna pada slider ke mana saja sesuai keinginan kita.sesuai keinginan kita.

7.7.   Double klik di titik-titik sepanjang slider gradasi. Titik-titik inilah yang akan Double klik di titik-titik sepanjang slider gradasi. Titik-titik inilah yang akan berisi warna baruberisi warna baru

selain warna yang sudah kita selain warna yang sudah kita tentukan sebelumnya (merah & hijau). Sehingga objek tersebuttentukan sebelumnya (merah & hijau). Sehingga objek tersebut

nantinya akan berisi lebih dari 2 warna gradasi.nantinya akan berisi lebih dari 2 warna gradasi.

Memilih warna baru cukupMemilih warna baru cukup

lewat property barlewat property bar

8.8.   Slider gradasi dan titik-titik warna masih dapat digeser atau Slider gradasi dan titik-titik warna masih dapat digeser atau dipindah.dipindah.

Mewarnai Objek Dengan Gradasi Mesh FillMewarnai Objek Dengan Gradasi Mesh Fill

Selain mewarnai gradasi dengan cara di atas, masih ada lagi cara membuat gradasi yang jauh lebihSelain mewarnai gradasi dengan cara di atas, masih ada lagi cara membuat gradasi yang jauh lebih

canggih dan fleksibel yaitu menggunakan teknikcanggih dan fleksibel yaitu menggunakan teknik MeshMesh. Fasilitas ini bermanfaat jika kita ingin membuat. Fasilitas ini bermanfaat jika kita ingin membuat

gradasi pada area tertentu saja sehingga gambar dapat seperti foto sungguhan.gradasi pada area tertentu saja sehingga gambar dapat seperti foto sungguhan.

Area tertentu tersebut adalah point-point dan segment atau titik dan segmen dimana masing-masingArea tertentu tersebut adalah point-point dan segment atau titik dan segmen dimana masing-masing

titik dan segmen dapat titik dan segmen dapat ditentukan kandungan warnanya.ditentukan kandungan warnanya.

Cara membuat gradasi Mesh denganCara membuat gradasi Mesh dengan Interactive Mesh Fill ToolInteractive Mesh Fill Tool : :

1.1.   Buat sebuah objek.Buat sebuah objek.

2.2.   Lalu klik iconLalu klik icon Interactive Mesh Fill ToolInteractive Mesh Fill Tool   ..  
3.3.   Objek akan berisi titik-titik yang mana satu titik tersebut dapat diisi warna. Sesuaikan handleObjek akan berisi titik-titik yang mana satu titik tersebut dapat diisi warna. Sesuaikan handle

dan posisi titiknya seperti kita mengedit sebuah kurva.dan posisi titiknya seperti kita mengedit sebuah kurva.
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Satu titik = satu warna.Satu titik = satu warna.
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Open Curved & Closed CurvedOpen Curved & Closed Curved
Dalam Coreldraw, ada beberapa macam obyek. Secara garis besar ialah :Dalam Coreldraw, ada beberapa macam obyek. Secara garis besar ialah :

   Primitives atau Basic ShapesPrimitives atau Basic Shapes

   TextText

   EffectsEffects

   CurveCurve

   Bitmap.Bitmap.

Pembuatan objek yang sesuai dengan keinginan sang designer dapat Pembuatan objek yang sesuai dengan keinginan sang designer dapat dimungkinkan dengan pembuatandimungkinkan dengan pembuatan

kurva (Curve). Baik itu kurva tkurva (Curve). Baik itu kurva terbuka atau pun kurva tertutup. Yang paling erbuka atau pun kurva tertutup. Yang paling mendasar adalah obyek yangmendasar adalah obyek yang

berjenis curve.berjenis curve.

   Kurva mudah diedit secara manual.Kurva mudah diedit secara manual.

   Kurva biasanya langsung disertai outline. outline tKurva biasanya langsung disertai outline. outline tersebut dapat dibuat transparan.ersebut dapat dibuat transparan.

   Kurva dapat diperoleh dengan membuatnya dengan curve tools (bezier, freehand, dsb).Kurva dapat diperoleh dengan membuatnya dengan curve tools (bezier, freehand, dsb).

   Kurva juga dapat diperoleh sebagai konversi dari primitives, teks, dan effects.Kurva juga dapat diperoleh sebagai konversi dari primitives, teks, dan effects.

   Kurva dapat dikonversi menjadi obyek bitmap sehingga tidak dapat diedit lagi.Kurva dapat dikonversi menjadi obyek bitmap sehingga tidak dapat diedit lagi.

LatihanLatihan

1.1.   Buatlah sebuah objek berbentuk rectangle lalu beri Buatlah sebuah objek berbentuk rectangle lalu beri fill dan outline.fill dan outline.

2.2.   Duplikasi rectangle tadi dengan tombol [+] pada Duplikasi rectangle tadi dengan tombol [+] pada numeric pad keyboard.numeric pad keyboard.
3.3.   NudgeNudge atau geser  atau geser salah satunya sehingga letak kesalah satunya sehingga letak kedua rectangle berddua rectangle berdampingan.ampingan.

4.4.   Pilih rectangle yang kanan dengan pick tool, Pilih rectangle yang kanan dengan pick tool, lalu tekanlalu tekan Ctrl+QCtrl+Q..

 Jika  Jika berhasil, berhasil, meskipun meskipun tampaknya tampaknya tetap tetap serupa, serupa, minimal minimal ada ada dua dua perbedaan perbedaan yang yang dapat dapat andaanda

perhatikan.perhatikan.

Pertama, jika anda tunjuk dengan pick tool, masing- masing object menunjukkan property bar yangPertama, jika anda tunjuk dengan pick tool, masing- masing object menunjukkan property bar yang

berbeda satu sama lainnya. Ini adalah sebagai akibat bahwa pada saat menekanberbeda satu sama lainnya. Ini adalah sebagai akibat bahwa pada saat menekan Ctrl+QCtrl+Q, kita merubah, kita merubah

salah satu rectangle menjadi curve. Jadi mengingat bahwa isi dari property bar tergantung jenis obyek,salah satu rectangle menjadi curve. Jadi mengingat bahwa isi dari property bar tergantung jenis obyek,

dan pick tool dapat kita anggap bersifat netral, maka jelas property bar akan menampilkan isi yangdan pick tool dapat kita anggap bersifat netral, maka jelas property bar akan menampilkan isi yang

berbeda jika anda memilih sebuah rectangle dibanding bila anda memilih sebuah curve, yang sudahberbeda jika anda memilih sebuah rectangle dibanding bila anda memilih sebuah curve, yang sudah

tentu memiliki Property Bar sendiri.tentu memiliki Property Bar sendiri.

Hal kedua yang dapat kita amati adalahHal kedua yang dapat kita amati adalah

seperti ditunjukkan oleh gambar.seperti ditunjukkan oleh gambar.
Tampak bahwa memindahkan control pointsTampak bahwa memindahkan control points
pada sebuah curve (meskipun merupakanpada sebuah curve (meskipun merupakan
hasil konversi dari rectangle), menghasilkanhasil konversi dari rectangle), menghasilkan
bentuk yang berbeda dengan jika andabentuk yang berbeda dengan jika anda
melakukan hal yang sama terhadapmelakukan hal yang sama terhadap
rectangle.rectangle.

TIPSTIPS ::
Untuk membuat sudut lengkung padaUntuk membuat sudut lengkung pada
Rectangle cukup seleksi rectangle lalu tekanRectangle cukup seleksi rectangle lalu tekan
F10. Kemudian geser salah satu sudutnyaF10. Kemudian geser salah satu sudutnya
sampai bentuk sudut yang diinginkansampai bentuk sudut yang diinginkan
terpenuhi.terpenuhi.

  

TekanTekan Ctrl+QCtrl+Q untuk merubah objek dasar / bas untuk merubah objek dasar / basic shape & teks menjadi Curve agar ic shape & teks menjadi Curve agar mudahmudah
diedit bentuknya.diedit bentuknya.
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Open CurveOpen Curve

Open Curve atau kurva terbuka tidak dapat berisi warna karena hanya terdiri dari oultine atau garis atauOpen Curve atau kurva terbuka tidak dapat berisi warna karena hanya terdiri dari oultine atau garis atau

juga segmen.juga segmen.

Angka = Node / Simpul, HAngka = Node / Simpul, Huruf = Segmenuruf = Segmen

NodeNode

Berikutnya, kita akan membicarakan tentangBerikutnya, kita akan membicarakan tentang nodenode. Perlu. Perlu

diketahui bahwa ada tiga macam node:diketahui bahwa ada tiga macam node: CuspCusp,, SmoothSmooth,,

dandan SymmetricalSymmetrical..

CuspCusp adalah satu- satunya jenis node yang dapat adalah satu- satunya jenis node yang dapat

membentuk sudut tajam. Pada contoh tampakmembentuk sudut tajam. Pada contoh tampak nodenode  

dengan jenisdengan jenis cuspcusp, membentuk sudut antara segment line, membentuk sudut antara segment line

dan curve.dan curve.

SymmetricalSymmetrical adalah adalah nodenode tidak bersudut atau tumpul yang tidak bersudut atau tumpul yang

mempunyai handle yang simetris atau sama panjang padamempunyai handle yang simetris atau sama panjang pada

kedua ujungnya.kedua ujungnya.

SedangkanSedangkan SmoothSmooth  mempunyai handle  mempunyai handle nodenode  yang tidak  yang tidak

sama panjang kedua ujungnya.sama panjang kedua ujungnya.

Menambah Menambah atau atau mengurangi mengurangi node node dapat dapat dilakukan dilakukan dengan dengan klik klik icon icon atau atau pada pada property property barbar

Shape ToolShape Tool atau double klik pada sebuah atau double klik pada sebuah segmen.segmen.

Untuk contoh lihat gambar berikut :Untuk contoh lihat gambar berikut :
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Closed CurveClosed Curve

Closed Curve atau kurva tertutup dapat berisi warna dan pembuatannya kurang lebih sama denganClosed Curve atau kurva tertutup dapat berisi warna dan pembuatannya kurang lebih sama dengan

Open Curve. Lihat penjelasan berikut untuk :Open Curve. Lihat penjelasan berikut untuk :

Pembuatan Closed Curve dari Open Curve.Pembuatan Closed Curve dari Open Curve.

Klik iconKlik icon ExtendExtend  

Curve to CloseCurve to Close

..

AtauAtau Join Two NodesJoin Two Nodes  

..

Pembuatan Closed Curve langsung.Pembuatan Closed Curve langsung.

Membuka Close CurveMembuka Close Curve
Close Curve atau kurva Close Curve atau kurva terutup dapat dibuka sehingga menjadi Open Curve. Icon yang digunakan adalahterutup dapat dibuka sehingga menjadi Open Curve. Icon yang digunakan adalah

Break CurveBreak Curve   ..

LATIHANLATIHAN
Buatlah gambar seperti di bawah ini (kurva tertutup).Buatlah gambar seperti di bawah ini (kurva tertutup).

11

22

1 1 22
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Pengolahan Objek Tingkat LanjutPengolahan Objek Tingkat Lanjut
Selain mempunyai kemampuan menggambar, CorelDRAW juga dibekali dengan kemampuanSelain mempunyai kemampuan menggambar, CorelDRAW juga dibekali dengan kemampuan

pengolahan objek tingkat lanjut. Seperti :pengolahan objek tingkat lanjut. Seperti :

BlendBlend

Pengertian BLEND adalah pencampuran 2 bentuk objek sehingga membentuk objek baru yangPengertian BLEND adalah pencampuran 2 bentuk objek sehingga membentuk objek baru yang

ditentukan oleh langkah atau step.ditentukan oleh langkah atau step.

Berikut ini langkah-langkah untuk membuat objek dengan efekBerikut ini langkah-langkah untuk membuat objek dengan efek BlendBlend..

1.1.   Buat 2 buah objek Buat 2 buah objek dengan bentuk yang berbeda.dengan bentuk yang berbeda.

2.2.   Seleksi kedua objek tersebut lalu klik iconSeleksi kedua objek tersebut lalu klik icon Interactive Blend ToolInteractive Blend Tool   di di tool tool box. box. Ingat,Ingat,

penekanan icon ini akan mengaktifkan Property Bar penekanan icon ini akan mengaktifkan Property Bar dari tool yang bersangkutan.dari tool yang bersangkutan.

3.3.   Keterangan dari masing-masing parameter :Keterangan dari masing-masing parameter :
Menentukan jenis-jenis blend.Menentukan jenis-jenis blend.

Menentukan apakah hasil blend berdasarkan jumlah step atau jarakMenentukan apakah hasil blend berdasarkan jumlah step atau jarak

per objek.per objek.

Menentukan jumlah step Menentukan jumlah step dan jarak objek dan jarak objek antar blend (denantar blend (dengan satuangan satuan

unit).unit).

Menentukan arah blend.Menentukan arah blend.

Menentukan akselerasi objek yang diblend.Menentukan akselerasi objek yang diblend.

Opsi blend tambahan seperti memecah blend dari Opsi blend tambahan seperti memecah blend dari objek induk.objek induk.

Menghapus efek blend pada suatu kumpulan objek.Menghapus efek blend pada suatu kumpulan objek.
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Berikut ini cara membuat blend yang mengikuti alur sebuah curve / path :Berikut ini cara membuat blend yang mengikuti alur sebuah curve / path :
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ContourContour

CONTOUR digunakan jika kita ingin membuat objekCONTOUR digunakan jika kita ingin membuat objek beranak pinak beranak pinak  dengan dimensi atau ukuran yang dengan dimensi atau ukuran yang

lebih kecil lebih kecil atau atau lebih besar dari aslinya lebih besar dari aslinya namun masih dengan namun masih dengan bentuk yang sama bentuk yang sama seperti induknya.seperti induknya.

Berikut ini langkah-langkah untuk membuat objek dengan efekBerikut ini langkah-langkah untuk membuat objek dengan efek ContourContour..

1.1.   Buat sebuah objekBuat sebuah objek

2.2.   Seleksi objek tersebut lalu klik iconSeleksi objek tersebut lalu klik icon Interactive Contour ToolInteractive Contour Tool   . . Ingat, Ingat, penekanan penekanan icon icon iniini
akan mengaktifkan Property Bar dari akan mengaktifkan Property Bar dari tool yang bersangkutan.tool yang bersangkutan.

3.3.   Keterangan dari masing-masing parameter lihat contoh Keterangan dari masing-masing parameter lihat contoh kasus di bawah..kasus di bawah..
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EnvelopeEnvelope

ENVELOPE bermafaat untuk membuat bentuk objek seperti terbungkus oleh sesuatu.ENVELOPE bermafaat untuk membuat bentuk objek seperti terbungkus oleh sesuatu.

Contoh kasus aplikasi Envelope sederhana pada sebuah Contoh kasus aplikasi Envelope sederhana pada sebuah objek (gambar-gambar efek Envelope di bawahobjek (gambar-gambar efek Envelope di bawah

menggunakan menggunakan Interactive Interactive Envelope Envelope Tool Tool ) ) ::

Envelope StraightEnvelope Straight

Line ModeLine Mode

KombinasikanKombinasikan

dengan penekanandengan penekanan

tomboltombol CtrlCtrl,, AltAlt,,

ShiftShift atau atau

Ctrl+ShiftCtrl+Shift untuk untuk

hasil yanghasil yang

bervariatif.bervariatif.

Envelope Single ArcEnvelope Single Arc

ModeMode

KombinasikanKombinasikan

dengan penekanandengan penekanan

tomboltombol CtrlCtrl,, AltAlt,,

ShiftShift atau atau

Ctrl+ShiftCtrl+Shift untuk untuk
hasil yanghasil yang

bervariatif.bervariatif.

Envelope DoubleEnvelope Double

Arc ModeArc Mode

KombinasikanKombinasikan

dengan penekanandengan penekanan

tomboltombol CtrlCtrl,, AltAlt,,

ShiftShift atau atau
Ctrl+ShiftCtrl+Shift untuk untuk

hasil yanghasil yang
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bervariatif.bervariatif.

EnvelopeEnvelope

Uncontrained ModeUncontrained Mode

Contoh lainnya :Contoh lainnya :
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ExtrudeExtrude

EXTRUDE merupakan penerapan bentuk 3 dimensi (3D) sebenarnya dari sebuah objek 2 dimensi,EXTRUDE merupakan penerapan bentuk 3 dimensi (3D) sebenarnya dari sebuah objek 2 dimensi,

berbeda dengan ENVELOPEberbeda dengan ENVELOPE. Karena dalam Extrude ada . Karena dalam Extrude ada penambahan titik kordinat Z selain penambahan titik kordinat Z selain X dan Y.X dan Y.

Buatlah sebuah objek lalu klik iconBuatlah sebuah objek lalu klik icon Interactive Extrude ToolInteractive Extrude Tool   yang yang akan akan memunculkan memunculkan propertyproperty

bar-nya. Tentukan jenis extrude melalui Preset, lalu masukkan ketebalan objek yang terekstrude. Geserbar-nya. Tentukan jenis extrude melalui Preset, lalu masukkan ketebalan objek yang terekstrude. Geser

slider Extrude sampai menuju bentuk 3D yang slider Extrude sampai menuju bentuk 3D yang diinginkan. Lihat gambar – gambar di bawah diinginkan. Lihat gambar – gambar di bawah ini.ini.

Icon-icon yang menentukan bentuk 3D ialah :Icon-icon yang menentukan bentuk 3D ialah :

Extrusion Type & Extrusion DepthExtrusion Type & Extrusion Depth, menentukan jenis extrusi dan tingkat, menentukan jenis extrusi dan tingkat

ketebalan extrusi.ketebalan extrusi.

VPVP (  ( Vanishing Point Vanishing Point  ), apakah diambil dari objeknya saja, berbagi vanishing ), apakah diambil dari objeknya saja, berbagi vanishing

Point dengan objek Extruded lain atau Point dengan objek Extruded lain atau dari halaman.dari halaman.

Extrude RotationExtrude Rotation, memutar objek yang sudah terekstrude. Bermanfaat jika, memutar objek yang sudah terekstrude. Bermanfaat jika

ingin menampilkan objek dari angle / ingin menampilkan objek dari angle / sudut pandang yang berbeda.sudut pandang yang berbeda.

ColorColor, menampilkan warna pada objek , menampilkan warna pada objek terekstrude apakah menggunakanterekstrude apakah menggunakan

warna bayangan atau ada warna lain yang dimasukkan.warna bayangan atau ada warna lain yang dimasukkan.

BevelBevel, menampilkan bevel atau semacam list yang bersifat arti, menampilkan bevel atau semacam list yang bersifat artistik distik di

sepanjang garis outline.sepanjang garis outline.LightingLighting, pencahayaan yang akan diterapkan ke , pencahayaan yang akan diterapkan ke objek yang terekstrudeobjek yang terekstrude

agar lebih realistik.agar lebih realistik.
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Satu lagi fasilitas di CorelDRAW untuk membuat efek 3D sederhana namun terkesan elegan adalahSatu lagi fasilitas di CorelDRAW untuk membuat efek 3D sederhana namun terkesan elegan adalah

membuat angle perspektif dengan cara klik pada objek yang bersangkutan lalu klik menu pull downmembuat angle perspektif dengan cara klik pada objek yang bersangkutan lalu klik menu pull down

Effects - > Add PerspectiveEffects - > Add Perspective..

BevelBevel

Masih dalam pembahasan ‘3D look’, BEVEL digunakan untuk mencapai kesan tombol atau timbulMasih dalam pembahasan ‘3D look’, BEVEL digunakan untuk mencapai kesan tombol atau timbul

(emboss) pada suatu objek. C(emboss) pada suatu objek. Cara mengaksesnya adalah dengan klik padara mengaksesnya adalah dengan klik pada sebuah a sebuah objek lalu masuk keobjek lalu masuk ke

menu pulldownmenu pulldown Effects - > BevelEffects - > Bevel sehingga akan  sehingga akan memunculkan menu BEVEL berbentukmemunculkan menu BEVEL berbentuk docker docker ..
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LensLens

LENS adalah pengolahan special effect pada objek sehingga menghasilkan efek optik tertentu. BiasanyaLENS adalah pengolahan special effect pada objek sehingga menghasilkan efek optik tertentu. Biasanya

efek-efek yang dihasilkan sangat berguna untuk membuat objek baru atau bahkan juga logo. Caraefek-efek yang dihasilkan sangat berguna untuk membuat objek baru atau bahkan juga logo. Cara

mengaksesnya adalah dengan masuk ke menu pulldownmengaksesnya adalah dengan masuk ke menu pulldown Effects - > LensEffects - > Lens sehingga akan memunculkan sehingga akan memunculkan

menu LENS berbentukmenu LENS berbentuk docker docker ..

Berikut ini beberapa contoh aplikasi penggunaan efek Lens pada sebuah artwork :Berikut ini beberapa contoh aplikasi penggunaan efek Lens pada sebuah artwork :
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Gambar kiri adalah gambar aslinya, sedangkan yang kananGambar kiri adalah gambar aslinya, sedangkan yang kanan

adalah adalah gambar ayam gambar ayam yang di’yang di’heat map’.heat map’.
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PERHATIAN!PERHATIAN!

Hasil gambar di atas hanyalah sekedar contoh saja. Tiap kasus pasti menghasilkan efek yang berbedaHasil gambar di atas hanyalah sekedar contoh saja. Tiap kasus pasti menghasilkan efek yang berbeda

pula. Usahakan sering-sering latihan untuk menguasai efek Lens ini. Karena tidak semua bentuk objekpula. Usahakan sering-sering latihan untuk menguasai efek Lens ini. Karena tidak semua bentuk objek

dapat di-Lens.dapat di-Lens.



  

   Menggambar Grafik Vektor Dengan CorelDRAW X4Menggambar Grafik Vektor Dengan CorelDRAW X4
  

   4343

PowerClipPowerClip

POWER CLIP bermanfaat untuk memasukkan objek baik itu vektor atau bitmap ke dalam sebuah objekPOWER CLIP bermanfaat untuk memasukkan objek baik itu vektor atau bitmap ke dalam sebuah objek

lain atau disebut container. Hasilnya adalah objek di dalam objek.lain atau disebut container. Hasilnya adalah objek di dalam objek.

Cara menggunakannya :Cara menggunakannya :

1.1.   Sebelumnya harus ada 2 buah objek, objek pertama adalah objek isi ( Sebelumnya harus ada 2 buah objek, objek pertama adalah objek isi ( content content  )  ) lalu lalu objek objek yangyang

kedua adalah objek penampung ( kedua adalah objek penampung ( container container  ). ).

2.2.   Klik objek yang akan dijadikan isi (content).Klik objek yang akan dijadikan isi (content).

3.3.   Lalu klik menu pulldownLalu klik menu pulldown Effects -> PowerClip -> Place Inside Container…Effects -> PowerClip -> Place Inside Container…  

4.4.   Lalu pilih menggunakan kursor panah besar objek penampung (container) yang akanLalu pilih menggunakan kursor panah besar objek penampung (container) yang akan

menampung objek isi tersebut.menampung objek isi tersebut.

Seperti terlihat di gambar berikut ini :Seperti terlihat di gambar berikut ini :

Objek texture = content,Objek texture = content,

Objek Text (harus diconvert terlebih dahulu menjadi Objek Text (harus diconvert terlebih dahulu menjadi kurva) = container.kurva) = container.

Objek texture masuk ke dalam objek text.Objek texture masuk ke dalam objek text.  
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Objek Raster Di CorelDRAWObjek Raster Di CorelDRAW
CorelDRAW memang ditujukan untuk membuat dan mengolah gambar berbasiskan vektor. Namun tidakCorelDRAW memang ditujukan untuk membuat dan mengolah gambar berbasiskan vektor. Namun tidak

tertutup kemungkinan untuk mengolah gambar raster atau bitmap. Jika ada satutertutup kemungkinan untuk mengolah gambar raster atau bitmap. Jika ada satu artwork artwork   yang  yang

membutuhkan gambar raster maka CorelDRAW sanggup mengolahnya di dalam interface atau antarmembutuhkan gambar raster maka CorelDRAW sanggup mengolahnya di dalam interface atau antar

muka program CorelDRAW itu sendiri tanpa bantuan software/program pengolah khusus foto sepertimuka program CorelDRAW itu sendiri tanpa bantuan software/program pengolah khusus foto seperti

 Adobe  Adobe PhotoshopPhotoshop  atau  atau Corel PHOTOPAINT Corel PHOTOPAINT . Tentu saja dengan kemampuan yang terbatas untuk. Tentu saja dengan kemampuan yang terbatas untuk

mengolahnya, tidak bisa melakukan hal-hal rumit seperti penerapan special effect pada foto.mengolahnya, tidak bisa melakukan hal-hal rumit seperti penerapan special effect pada foto.

 Jika  Jika ingin ingin serius serius dalam dalam mengolah mengolah foto foto apalagi apalagi dengan dengan penambahan penambahan special special effect effect disarankandisarankan

menggunakan software terpisah seperti yang telah disebut di atas. Jika terpaksa dikerjakan dimenggunakan software terpisah seperti yang telah disebut di atas. Jika terpaksa dikerjakan di

CorelDRAW maka hasilnya akan kurang optimal.CorelDRAW maka hasilnya akan kurang optimal.

Selain kemampuan membuat gambar vektor, CorelDRAW juga mampu membuat dan menghasilkanSelain kemampuan membuat gambar vektor, CorelDRAW juga mampu membuat dan menghasilkan

gambar raster/bitmap seperti untuk keperluan web, animasi, gambar raster/bitmap seperti untuk keperluan web, animasi, wallpaper dan lain-lain.wallpaper dan lain-lain.

Import File Bitmap/RasterImport File Bitmap/Raster

Lalu apa yang akan kita lakukan jika dalam suatu proyek dibutuhkan gabungan antara grafik vektor danLalu apa yang akan kita lakukan jika dalam suatu proyek dibutuhkan gabungan antara grafik vektor dan
bitmap (raster). Pada CorelDRAW hal ini bukan masalah. Kita dapat membuat grafik vektor padabitmap (raster). Pada CorelDRAW hal ini bukan masalah. Kita dapat membuat grafik vektor pada

CorelDRAW lalu mengimport atau mengambil file grafik bitmap agar disatukan dalam suatu kesatuanCorelDRAW lalu mengimport atau mengambil file grafik bitmap agar disatukan dalam suatu kesatuan

artwork.artwork.

Sebelum mengimpor file bitmapSebelum mengimpor file bitmap Setelah mengimpor file bitmapSetelah mengimpor file bitmap
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Berikut ini cara menyatukan gambar raster/bitmap ke dalam artwork berbasikan vektor di CorelDRAW :Berikut ini cara menyatukan gambar raster/bitmap ke dalam artwork berbasikan vektor di CorelDRAW :

1.1.   Buka dokumen baru atau dokumen CorelDRAW yang sudah ada.Buka dokumen baru atau dokumen CorelDRAW yang sudah ada.

2.2.   Klik iconKlik icon ImportImport.. .. atau atau tekantekan Ctrl+ICtrl+I..

3.3.   Kotak dialog Import File terbuka. Pilih file raster/bitmap yang ingin kita masukkan ke dalamKotak dialog Import File terbuka. Pilih file raster/bitmap yang ingin kita masukkan ke dalam

dokumen kita.dokumen kita.

4.4.   Tentukan lokasi penempatan objek raster/bitmap tersebut pada artwok kita lalu klik.Tentukan lokasi penempatan objek raster/bitmap tersebut pada artwok kita lalu klik.

5.5.   Objek raster/bitmap sudah menyatu pada dokumen kita.Objek raster/bitmap sudah menyatu pada dokumen kita.

6.6.   Objek raster akan berada pada urutan teratas. Gunakan context menu (klik kanan)Objek raster akan berada pada urutan teratas. Gunakan context menu (klik kanan) OrderOrder  lalu  lalu

pilihpilih Back OneBack One (  ( Ctrl+PgDnCtrl+PgDn ). ).

7.7.    Jika ingin mengedit gamb Jika ingin mengedit gambar raster tersebut dapat menggunakan menu par raster tersebut dapat menggunakan menu pull downull down BitmapBitmap..

Satu hal yang harus diingat adalah semakin banyak dan besar objek raster yang kita import maka akanSatu hal yang harus diingat adalah semakin banyak dan besar objek raster yang kita import maka akan

semakin besar ukuran file kerja semakin besar ukuran file kerja kita. Ini berpengaruh langsung pada kecepatan komputer.kita. Ini berpengaruh langsung pada kecepatan komputer.
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Export File Bitmap/RasterExport File Bitmap/Raster

Seperti telah disebutkan di atas, selain dapat menghasilkan file vektor, CorelDRAW juga dapatSeperti telah disebutkan di atas, selain dapat menghasilkan file vektor, CorelDRAW juga dapat

menghasilkan file bitmap atau format vektor lain untuk beberapa keperluan. Cara ini disebut denganmenghasilkan file bitmap atau format vektor lain untuk beberapa keperluan. Cara ini disebut dengan

Export Export , artinya kita menghasilkan file gambar selain berformat st, artinya kita menghasilkan file gambar selain berformat standar CorelDRAWandar CorelDRAW (.cdr (.cdr  ). ).

Berikut cara mengekspor gambar ke format lain :Berikut cara mengekspor gambar ke format lain :

1.1.   Seperti biasa, artwork atau gambar yang kita buat di CorelDRAW harus sudah terbuka.Seperti biasa, artwork atau gambar yang kita buat di CorelDRAW harus sudah terbuka.

2.2.   Klik menu pull downKlik menu pull down File -> ExportFile -> Export..

3.3.   Kotak dialogKotak dialog ExportExport akan terbuka. akan terbuka.

4.4.   Silahkan pilih format file yang diinginkan. Lalu klik Ok.Silahkan pilih format file yang diinginkan. Lalu klik Ok.

5.5.    Jika  Jika kita kita akan akan menyimpan menyimpan ke ke dalam dalam bentuk bentuk bitmap bitmap maka maka akan akan ada ada lagi lagi kotak kotak dialog, dialog, yaituyaitu

Convert To BitmapConvert To Bitmap..

6.6.   Lalu klik Ok untuk mengekspor artwork.Lalu klik Ok untuk mengekspor artwork.

Kenapa Gambar Harus Diexport?Kenapa Gambar Harus Diexport?

Karena :Karena :

    Jika kita ingin mengirimkan gambar ke  Jika kita ingin mengirimkan gambar ke orang lain yang tidak mempunyai program CorelDorang lain yang tidak mempunyai program CorelDRAW diRAW di

komputernya, orang tersebut nasih dapat melihat gambar kita.komputernya, orang tersebut nasih dapat melihat gambar kita.

Misalnya, mengirim surat lamaran beserta CD portfolio dalam bentuk file Jpeg.Misalnya, mengirim surat lamaran beserta CD portfolio dalam bentuk file Jpeg.

    Jika kita ingin membuat gambar yang akan dimu Jika kita ingin membuat gambar yang akan dimuat ke dalam situs web.at ke dalam situs web.

Situs web mengharamkan penampilan format gambar selain Situs web mengharamkan penampilan format gambar selain format Jpeg, GIF, PNG dan format Jpeg, GIF, PNG dan SVG.SVG.

   Memasukkan gambar kita ke dalam program lain agar dapat mudah dibaca dan dipakai.Memasukkan gambar kita ke dalam program lain agar dapat mudah dibaca dan dipakai.
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Menu DockersMenu Dockers
At last but not least, menuAt last but not least, menu DockersDockers. Menu yang secara default berada pada sisi kanan interface. Menu yang secara default berada pada sisi kanan interface

program CorelDRAW, berdampingan denganprogram CorelDRAW, berdampingan dengan Color PaletteColor Palette..

Cara mengakses menu Dockers dengan klikCara mengakses menu Dockers dengan klik Window -> Dockers.Window -> Dockers.

Lalu pilih menu yang akan di-Lalu pilih menu yang akan di-dockingdocking..

Contoh menu Dockers yangContoh menu Dockers yang

terbagi dari beberapa tab.terbagi dari beberapa tab.

Fungsi parameter yang berada padaFungsi parameter yang berada pada DockersDockers tidak berbeda dengan menu di tidak berbeda dengan menu di Property BarProperty Bar, hanya ada, hanya ada

beberapa perbedaan dalam cara penanganan objek. Karena keduanya memang berisi beberapabeberapa perbedaan dalam cara penanganan objek. Karena keduanya memang berisi beberapa

parameter yang digunakan untuk pengolahan suatu objek namun dengan cara yang berbeda.parameter yang digunakan untuk pengolahan suatu objek namun dengan cara yang berbeda.

Lihat gambar berikut :Lihat gambar berikut :
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Gambar di atas adalah gambar Star dengan Property Bar-nya. PropertyGambar di atas adalah gambar Star dengan Property Bar-nya. Property

Bar berisi beberapa pengaturan / parameter setting untuk gambar StarBar berisi beberapa pengaturan / parameter setting untuk gambar Star

yang bersangkutan. Sedangkan gambar di samping adalah menuyang bersangkutan. Sedangkan gambar di samping adalah menu

Docker yang berisi Object Properties dari gambar Star.Docker yang berisi Object Properties dari gambar Star.

Kesimpulan: Jadi suatu objek mempunyai settingan parameter masing-Kesimpulan: Jadi suatu objek mempunyai settingan parameter masing-

masing di dua tempat:masing di dua tempat:

••   di Property Bar dandi Property Bar dan

••   di Object Properties.di Object Properties.

Menu-Menu DockersMenu-Menu Dockers

Berikut beberapa contoh penggunaan menu Dockers :Berikut beberapa contoh penggunaan menu Dockers :

1.1.   Rotasi ObjekRotasi Objek

Pada menuPada menu Dockers –Dockers –

TransformationTransformation, klik icon Rotate., klik icon Rotate.

Masukkan nilai Angle 12 deg. LaluMasukkan nilai Angle 12 deg. Lalu

KlikKlik Apply To DuplicateApply To Duplicate  

beberapa kali sampai gambarbeberapa kali sampai gambar

seperti di bawah terbentuk.seperti di bawah terbentuk.
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2.2.   Shaping / Membentuk ObjekShaping / Membentuk Objek

Seperti sudah dijelaskan padaSeperti sudah dijelaskan pada

bab terdahulu, menubab terdahulu, menu ShapingShaping  

terdiri dari beberapa fungsiterdiri dari beberapa fungsi

untuk membentuk objek baru :untuk membentuk objek baru :

   WeldWeld  

mengelas/menyambungmengelas/menyambung

objek.objek.
   TrimTrim memotong mengikuti memotong mengikuti

bentuk objek pemotong.bentuk objek pemotong.

   IntersectIntersect mendapatkan mendapatkan

gambar gambar perpotongannyperpotongannya.a.

   SimplifySimplify gambar tumpukan gambar tumpukan

teratas memotong gambar diteratas memotong gambar di

bawahnya.bawahnya.

   Front Minus BackFront Minus Back

   Back Minus FrontBack Minus Front

Selain menu-menu Dockers, masih ada lagi Selain menu-menu Dockers, masih ada lagi beberapa menu Dockers.beberapa menu Dockers.

Berfungsi untuk mengoplosBerfungsi untuk mengoplos

warnawarna


